ArcGIS 9
ArcGIS Data Interoperability Tutorial
Copyright © 2006 ESRI
All rights reserved.
Printed in the United States of America.

The information contained in this document is the exclusive property of ESRI. This work is protected under United States copyright law and other international copyright treaties and conventions. No part of this work may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, or by any information storage or retrieval system, except as expressly permitted in writing by ESRI.
All requests should be sent to Attention: Contracts and Legal Services Manager, ESRI, 380 New York Street, Redlands, CA 92373-8100, USA.

The information contained in this document is subject to change without notice.

CONTRIBUTING WRITERS
Jeff Reinhart, Phil Sanchez, Kim Avery

U.S. GOVERNMENT RESTRICTED/LIMITED RIGHTS

Any software, documentation, and/or data delivered hereunder is subject to the terms of the License Agreement. In no event shall the U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS. At a minimum, use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in FAR §52.227-14 Alternates I, II, and III (JUN 1987); FAR §52.227-19 (JUN 1987) and/or FAR §12.211/12.212 (Commercial Technical Data/Computer Software); and DFARS §252.227-7015 (NOV 1995) (Technical Data) and/or DFARS §227.7202 (Computer Software), as applicable.
Contractor/Manufacturer is ESRI, 380 New York Street, Redlands, CA 92373-8100, USA.

ESRI, ArcGIS, ArcCatalog, ArcToolbox, ArcMap, ArcInfo, and 3D Analyst are trademarks, registered trademarks, or service marks of ESRI, registered in the United States, the European Community, or certain other jurisdictions.

Other companies and products mentioned herein are trademarks or registered trademarks of their respective trademark owners.
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Getting started</strong> 1</td>
</tr>
<tr>
<td><strong>1 Performing a direct read of interoperability data</strong> 3</td>
</tr>
<tr>
<td>Exercise 1: Using the ArcCatalog tree 5</td>
</tr>
<tr>
<td>Exercise 2: Using the Interoperability Connections node 7</td>
</tr>
<tr>
<td>Exercise 3: Interoperability in the ArcMap environment 12</td>
</tr>
<tr>
<td><strong>2 Translating Data using Quick Import and Quick Export</strong> 15</td>
</tr>
<tr>
<td>Exercise 1: Adding Quick Import and Quick Export tools to ArcToolbox 16</td>
</tr>
<tr>
<td>Exercise 2: Importing data using Quick Import 17</td>
</tr>
<tr>
<td>Exercise 3: Exporting data using Quick Export 19</td>
</tr>
<tr>
<td>Exercise 4: Using Quick Import and Quick Export in ModelBuilder 21</td>
</tr>
<tr>
<td><strong>3 Transforming data using Spatial ETL</strong> 27</td>
</tr>
<tr>
<td>Exercise 1: Using Spatial ETL to transform data to a geodatabase 28</td>
</tr>
<tr>
<td>Exercise 2: Using Spatial ETL to transform data from a geodatabase 40</td>
</tr>
<tr>
<td><strong>Appendix A Getting started with Workbench</strong> 49</td>
</tr>
<tr>
<td>Workbench interface 50</td>
</tr>
<tr>
<td>Menu bar and toolbar 51</td>
</tr>
<tr>
<td>Workbench elements 52</td>
</tr>
<tr>
<td>Quick changes 53</td>
</tr>
<tr>
<td>Log 54</td>
</tr>
</tbody>
</table>
IN THIS CHAPTER

• Making sure Data Interoperability is visible in ArcCatalog
• Enabling the ArcGIS Data Interoperability extension
• Adding the Data Interoperability Tools to ArcToolbox

Welcome to ESRI® ArcGIS® Data Interoperability extension. This tutorial guides you through some basic Data Interoperability skills.

This tutorial is designed to let you explore the capabilities of Data Interoperability at your own pace and without the need for additional assistance. You'll need about 30–40 minutes of focused time to complete the tutorial. However, you can also perform the exercises one at a time if you wish.
To enable the ArcGIS Data Interoperability extension, you may have to perform one or more of the following steps from within ArcGIS.

**Making sure Data Interoperability is visible in ArcCatalog**

1. Start ArcCatalog™ and from the Tools menu, click Options.
2. Click the General tab.
3. Under What top level entries do you want the Catalog to contain, check the Interoperability Connections check box.
4. Under Which types of data do you want the Catalog to show, check the Interoperability Data check box.

**Enabling the ArcGIS Data Interoperability extension**

1. From the ArcCatalog Tools menu, click Extensions.
2. Check the Data Interoperability check box.

**Adding the Data Interoperability Tools to ArcToolbox**

1. If the ArcToolbox window is not open, from the ArcCatalog Window menu, click ArcToolbox™.
2. Right-click the ArcToolbox name and click Add Toolbox.
3. Browse to the Toolboxes folder which is located at the top level, under the ArcCatalog node.
4. Click the System Toolboxes folder and choose Data Interoperability Tools.
Performing a direct read of interoperability data

IN THIS CHAPTER

• Exercise 1: Using the ArcCatalog tree
• Exercise 2: Using the Interoperability Connections node
• Exercise 3: Interoperability in the ArcMap environment

Welcome to ESRI® ArcGIS® Data Interoperability extension. This tutorial guides you through some basic Data Interoperability skills. This tutorial is designed to let you explore the capabilities of the Data Interoperability Extension at your own pace and without the need for additional assistance. You’ll need about 30–40 minutes of focused time to complete the tutorial. However, you can also perform the exercises one at a time if you wish.
You have received data in a variety of formats and you would like to familiarize yourself with the data.
Exercise 1: Using the ArcCatalog tree

In this exercise, you will use the Catalog tree to see how the Data Interoperability extension enables new formats to be easily viewed within ArcCatalog.

1. Navigate to the C:\arcgis\ArcTutor\Data_Interoperability\Tutorial folder in the Catalog (this is the default installation folder for the tutorial data).

2. Click flood_plains.tab.

3. Click the Preview tab to see the data.

When viewing a dataset for the first time, the Data Interoperability extension will index the dataset to improve performance.

Note that many other interoperability formats can be viewed in the same way.

Unlike ESRI formats, many other formats allow multiple geometries per dataset. When you first load a dataset, all possible geometries are shown. Once a dataset has been cached, the Data Interoperability extension can determine which feature classes are populated.

4. Refresh the parent folder to prune empty feature classes.

Click the Tutorial folder (C:\arcgis\ArcTutor\Data_Interoperability, by default) and press F5 or right-click and click Refresh. If the layers for the MapInfo (TAB) files were expanded, they will collapse. Expand subdivisions.tab and note that only populated feature classes are now listed.

5. Click on the subdivisions Polygon feature class.

6. Switch to Table preview mode to see the attributes for the feature class.

7. Switch back to Geography preview mode.
8. Use the Identify tool to select and view feature attributes.

9. Click the Metadata tab and click the Description, Spatial, and Attributes tabs to access the metadata for the feature class.

You have now completed Exercise 1: Using the ArcCatalog tree.
Exercise 2: Using the Interoperability Connections node

While you can simply browse many formats in ArcCatalog, some formats may require that you specify additional information, such as a username and password, before you can view the data, and other formats may not be identifiable via their filename extension. The Interoperability Connections node provides a way to fully specify both a format and all of its required settings, so that you can directly work with its data.

In this exercise, you will use the Interoperability Connections node to view Intergraph® Modular Geographic Information System (GIS) Environment (MGE) files. The MGE format is based on MicroStation® Design, with nongraphical elements defined through links to a database.

Follow the steps below to add a new Interoperability Connection in ArcCatalog for the MGE dataset found in the Parcels folder.

1. Under the Interoperability Connections node, double-click Add Interoperability Connection.

This opens the Interoperability Connection dialog box.
2. Click the Format browse button. The Formats Gallery dialog box appears. Type “mge” in the Search field and hit Enter.

3. Click OK to select Intergraph MGE as the format.

4. Click the Dataset browse button. Navigate to the C:\arcgis\ArcTutor\Data_Interoperability\Tutorial\parcels folder (this is the default installation) and select parcel_K24.par.

5. To view files with .par file extensions, you will need to change Files of type to All Files.

6. Click parcel_K24.par.

7. Click the Settings button.

The MGE Input Settings dialog box appears. To specify the Access database that contains the MGE attributes, click Access MDB as the Database Type, and browse to parcel_atrs.mdb in the parcels folder. This will fill in the Access MDB File textbox.
6. Click OK to close the MGE Input Settings dialog box.

7. Click the Coordinate System button in the Interoperability Connection dialog box to open the Spatial Reference Properties dialog box. This dialog box may be empty, or the last used Coordinate System may have already been preselected.

8. Click the Select button and navigate to Projected Coordinate Systems\State Plane\NAD 1983 (Feet).

9. Select the NAD 1983 StatePlane Texas Central FIPS 4203 (Feet).prj projection and Click the Add button to return to the Spatial Reference Properties dialog box, which is now populated.
10. Click OK to return to the Interoperability Connection dialog box. The Interoperability Connection dialog box now displays the coordinate system name.

11. Click OK. The new connection will be listed under Interoperability Connections and will be named something similar to Connection (1)—parcel_K24 MGE. Rename it as parcels_K24.

12. Preview the LOT_LINES Line feature class. When previewing a dataset for the first time, the Data Interoperability extension will index the dataset to improve performance.

13. Select parcels_K24 and choose Refresh from the View menu. Refreshing the connection causes only the populated feature classes to be listed.

14. Preview the LOT_LINES Line feature class again. This time use the Identify tool to click a line. Observe the new MGE attributes.
You have now completed Exercise 2: Using the Interoperability Connections node. In the next exercise, you will examine how interoperability data acts within ArcMap™.
**Exercise 3: Interoperability in the ArcMap environment**

Follow the steps below to open the Parcels MGE data source in ArcMap. (Note that if the extension is not yet enabled in ArcMap, you must enable it.)

1. Launch ArcMap, then drag and drop the parcels_K24 interoperability connection into the Layers pane of ArcMap. By dragging the entire node, all feature classes in the connection will be added.

   You will see the LOT_POINTS Point and LOT_LINES Line feature classes.

2. Right-click the subdivisions Polygon layer and click Properties. Click the Fields tab and ensure that the SUBDIVISION field is the Primary Display Field.

From ArcCatalog, browse to C:\arcgis\ArcTutor\Data_Interoperability\ folder. Select subdivisions.tab and drag the subdivisions Polygon feature class into ArcMap. Do the same for flood_plains.mif by browsing to the file in ArcCatalog, then dragging the parcels Polygon feature class into ArcMap.
3. Click the Display tab and check the Show MapTips box.

4. Click the Symbology tab, then click Categories, and click Unique values. Change the Value Field to ADD_DATE. Then, by clicking the Add All Values button, you will have added a legend item for each individual date that a subdivision was added to the survey.

5. Click OK to return to ArcMap, and observe the new symbology. Hover over the subdivisions to see the names displayed in MapTips.
6. Search for Gaston Park and zoom in on it. To do this, click on the Selection menu and choose Select By Attributes. Set the Layer to subdivisions Polygon. Double-click the SUBDIVISION field, click Like, add a space and then type “GAS%” in the text box so the query will select Gaston Park using a wildcard search. The query should look like:
“SUBDIVISION” LIKE ‘GAS%’

7. Click Apply, then click Close. Zoom to Full Extent and observe and hover over the selected feature to see GASTON PARK.

8. Click the Selection menu and click Zoom To Selected Features.

As you can see, interoperability feature classes behave very much like native data in ArcMap.

You have now completed Exercise 3: Interoperability in the ArcMap environment.

In the next chapter, you will use the Quick Import functionality to import data into the ArcGIS environment.
Translating Data using Quick Import and Quick Export

IN THIS CHAPTER

- Exercise 1: Adding Quick Import and Quick Export tools to ArcToolbox
- Exercise 2: Importing data using Quick Import
- Exercise 3: Exporting data using Quick Export
- Exercise 4: Using Quick Import and Quick Export in ModelBuilder

In the previous exercises, you used the direct read capabilities of ArcGIS Data Interoperability to directly read various non-native file formats. Next, you will use the Quick Import functionality to import data into the ArcGIS environment. This is useful in situations where you want to bring data into your system for editing or geoprocessing. Whereas direct read worked directly with the original data, Quick Import imports the original data into file geodatabase.

You will then use Quick Export to quickly and easily export data from ArcGIS to any of the supported formats. Together, Quick Import and Quick Export enable ArcGIS to be used as a central geoprocessing hub, regardless of format.
Exercise 1: Adding Quick Import and Quick Export tools to ArcToolbox

For this exercise, you will first import zoning data from Geography Markup Language (GML) into ArcGIS. You will then use Quick Export to export the data to MapInfo® TAB. Finally, you will use Quick Import and Quick Export within ModelBuilder™ to perform a Dissolve operation to dissolve and aggregate polygons by zoning type, removing the tiling within the original GML dataset. The resulting data will then be exported to GML and MapInfo TAB.

The Quick Import and Quick Export tools are located within the Data Interoperability Tools toolbox. To use them, you must first add the toolbox to ArcToolbox. This is not required if this step has already been done.

1. Open the ArcToolbox window in ArcCatalog by clicking the Toolbox icon on the toolbar.

2. To add a new toolbox, right-click ArcToolbox and click Add Toolbox.

3. Browse to the System Toolboxes folder under Catalog/Toolboxes, click Data Interoperability Tools, and click Open.

You have successfully completed Exercise 1: Adding Quick Import and Quick Export tools to ArcToolbox and added the Data Interoperability Tools toolbox to ArcToolbox. Now you are ready to use Quick Import and Quick Export.
Exercise 2: Importing data using Quick Import

1. To perform Quick Import on the zoning GML data, double-click the Quick Import tool within the Data Interoperability Tools toolbox.

For this exercise, you want to import zoning.gml into a file geodatabase called zoning.gdb. The input data is located in C:\arcgis\ArcTutor\Data_Interoperability\Tutorial\zoning.

2. Click the Input Dataset browse button to open the Specify Input Data Source dialog box. Specify the Geography Markup Language (GML) format and zoning.gml dataset.

When you specify the input dataset, the tool will, in many cases, read the file extension and automatically fill in the format. You will still need to verify that the correct format was filled in since, in some cases, a file extension is associated with multiple formats.
3. Click OK to close the dialog box and return to the Quick Import. Leave the output staging geodatabase as \ArcTutor\Data_Interoperability\Tutorial\zoning\zoning.gdb.

4. Click OK from the Quick Import window.
While the import operation is being performed, a progress window displays information on the progress of the import process, along with statistics of the number of features imported and the processing time.
The status window displays until you click Close.

5. You can now view the zoning geodatabase to see the imported data in ArcCatalog.

You have successfully completed Exercise 2: Importing data using Quick Import on the GML data.

Next, use the imported GML data to export data from the geodatabase you created above to native MapInfo TAB format.
Exercise 3: Exporting data using Quick Export

1. Double-click the Quick Export tool within the Data Interoperability Tools toolbox to perform Quick Export on the zoning data.

2. Specify the zoning feature class in the Quick Export dialog box Input Layer from the geodatabase created previously.

3. Click the Browse button in the Quick Export dialog box Output Dataset. The Specify Output Data Destination dialog box displays. Specify the Format as MapInfo TAB. Set the Dataset to the Tutorial\zoning folder.

4. The Quick Export window displays. Click OK to complete the export operation.

The window displays information on the progress of the import process, along with statistics of the number of features imported and the processing time.
The window displays until you close it.

You have successfully completed Exercise 3: Exporting data using Quick Export to export data from ArcGIS. This is useful for sharing data with users who don’t have the capability to directly read ArcGIS data. Using ArcCatalog, browse to the directory and see the zoning data in native MapInfo TAB format.
Exercise 4: Using Quick Import and Quick Export in ModelBuilder

This exercise demonstrates how to use Quick Import and Quick Export within the ArcGIS geoprocessing environment. You’ll see how ArcGIS can also be used as a geoprocessing environment, even if the data is not stored within ArcGIS.

Using Quick Import, import the data into ModelBuilder, dissolve the polygons of the zones, and export the data to GML and MapInfo TAB.

1. First create your own model. Create a user toolbox in which to place the model. Right-click the ArcToolbox root node and click New Toolbox.

   ![Toolbox Image]

A new toolbox is created named Toolbox.

2. Right-click Toolbox and click Rename. Rename the toolbox QuickImportExportTutorial.

3. Right-click the toolbox you created and click New then click Model.

   ![Model Image]

An empty model within ModelBuilder is created.
4. Drag the Dissolve tool (located in the Data Management toolbox under the Generalization set of tools) onto the model.

5. Drag the Quick Import tool from the Data Interoperability toolbox. Drag the Select Data tool from Data Management Tools > General toolbox.

6. Double-click the Quick Import tool and click Input Dataset.

The ModelBuilder window displays.

The Specify Input Data Source dialog box appears.
7. Select the GML as the source format and \ArcTutor\Data_Interoperability\Tutorial\zoning\zoning.gml as the source dataset. Click OK to close the Specify Input Data Source dialog box. The Quick Import dialog box will automatically populate.

8. Click OK to close the dialog box.

The ModelBuilder window appears.

9. Click the Add Connection tool and drag the connector from zoning.gdb to Select Data. Double-click the Select Data tool in ModelBuilder and ensure the Child Data Element Parameter is set to Zoning Polygon. Close the tool dialog box.

10. Click the Add Connection tool and drag the connector from Output Data to Dissolve.

The result displays in the ModelBuilder window.

11. Right-click Dissolve and click Open. Since you want to dissolve only by the type attribute, check the type box under Dissolve_Field(s). Specify the Output Feature Class as \ArcTutor\Data_Interoperability\Tutorial\zoning\zoning_Dissolve.shp.

12. Click OK to close the Dissolve window.
The result displays in the ModelBuilder window.

13. Click the Model menu and choose Run Entire Model. The Model status window appears and displays a processing log. When processing is complete, click Close to dismiss the window.


Notice the effects of the Dissolve operation on the data. In the original data, there were tiles overlaid; with the dissolve, the tiles are gone. Take a look at the original data to review the effects of the Dissolve operation.

15. To export the data back to GML and MapInfo TAB, drag and drop two Quick Export tools onto the ModelBuilder window.
16. Rename the tools. Right-click Quick Export, click Rename, and type Quick Export GML. Right-click Quick Export (2), click Rename, and type Quick Export MapInfo.

17. Click the Add Connection tool and drag the connector from zoning_dissolve.shp to Quick Export GML.

18. Click the Add Connection tool and drag the connector from zoning_dissolve.shp to Quick Export MapInfo. The ModelBuilder window should now look like this.

19. Set the output data destination for GML. Double-click the Quick Export GML tool, and then click the Browse button in the Output Dataset field.

20. The Specify Output Data Destination dialog box appears. Choose GML Version 2.x as the format and zoning_output.gml as the dataset. Click OK to close the dialog box.

21. Click OK to close the Quick Export GML window.
22. Set the output data destination for MapInfo TAB. Double-click the Quick Export MapInfo tool and click the Browse button in the Output Dataset field. Choose MapInfo TAB as the format. Click the Browse button in the dataset field and browse to the zoning folder. Click Open.

![Specify Output Data Destination](image)

23. Click OK to close the Specify Output Data Destination dialog box.

24. Click OK to close the Quick Export MapInfo window.

25. Run the model and view the output MapInfo TAB file, zoning_Dissolve.tab, and the GML file, zoning_output.gml, shown below.

![Model Output](image)

At the beginning of this chapter, you learned how to use Quick Import and Quick Export to facilitate data sharing. In the latter part of this chapter, you used ArcGIS Data Interoperability to enhance the geoprocessing capabilities of ArcGIS by integrating data from other systems directly into a geoprocessing model.

You have now completed Exercise 4: Using Quick Import and Quick Export in ModelBuilder.
IN THIS CHAPTER

- Exercise 1: Using Spatial ETL to transform data to a geodatabase
- Exercise 2: Using Spatial ETL to transform data from a geodatabase

You can use ArcGIS Data Interoperability to quickly and efficiently perform sophisticated manipulations to data as it is being moved into or out of ArcGIS. The Workbench application provides a graphical environment for modeling geometry and schema transformations, which become Spatial ETL tools.

In this exercise, you will use Workbench to set up a Spatial ETL that manipulate their input data to create output that exactly matches your requirements.

You’ve received the first of many data files in Intergraph® MGE. The data is tiled and contains no polygonal topology. You would like to have a convenient way to view or import the data while transforming it into something more meaningful.
Exercise 1: Using Spatial ETL to transform data to a geodatabase

In this exercise, you will use the ArcCatalog browse tree to see how the Data Interoperability extension enables new formats to be easily viewed within ArcCatalog.

If the ArcToolbox pane is not visible from within ArcCatalog, add it by clicking the Show/Hide ArcToolbox button.

If the ArcToolbox pane is not visible from within ArcCatalog, add it by clicking the Show/Hide ArcToolbox button.

Creating the Spatial ETL tool


2. Rename the new toolbox “Import Tools”. Right-click the Import Tools toolbox and click New then click Spatial ETL Import Tool.

3. Click Next on the Create Custom Translation Workspace Wizard.
4. Click the Browse button "..." to display the Formats Gallery, and double-click Intergraph MGE. Click Next.

5. Click the Add Source Datasets button.

6. This will display a dialog box that allows you to select multiple files and folders. Click the Add Folder button to browse to the folder \ArcTutor\Data_Interoperability\Tutorial\parcels and click Open.

7. In our example, the MGE files do not have the standard .dgn extension; instead, they have a .par extension. Double-click .dgn in the File/Filter column to display the Edit File/Filter dialog box. Change the file extension to *.par.

8. Click OK to close the Edit File/Filter dialog box. Dismiss the Select Source Intergraph MGE Files dialog by clicking OK and return to the Locate Sample Source Data window.
9. Click the Settings button to display the Intergraph MGE Input Settings dialog box. From here, you can pick which database holds the MGE attributes.

10. In the Database Type field, choose Access MDB. In the Access MDB File field, browse to \ArcTutor\Data_Interoperability\Tutorial\parcels\parcels_attrs.mdb. In this case, the default settings in the remaining fields are acceptable.

11. Click OK to close the dialog box and return to the Locate Sample Source Data window.

12. Click Next.

13. When prompted to Select Destination Format, click Browse ... to display the Formats Gallery and double-click ESRI Geodatabase (File-based). Click Next.

14. Click Next and click Finish. After all the data is read, Workbench will start.

Note: For more information on Workbench, see Appendix A or view the Data Interoperability Help files from within ArcGIS.
15. Select and delete the nodes indicated below (in red boxes).

16. Only these destination features should remain: LOT_LINES_LINE and LOT_POINTS_POINT.

17. Click Save and click Exit to close Workbench.

18. In ArcToolbox, right-click the Spatial ETL Tool and click Rename. Type “Import MGE Parcels” as the tool name.
19. Double-click Import MGE Parcels to display the Import MGE Parcels window. Accept the default location that appears in the Output Staging Geodatabase field.

20. Click OK to run the tool. The Import MGE status window displays the processing log. When processing is complete, click Close.

21. You can examine the resulting geodatabase in ArcCatalog to view the results. You will see that it contains the lines and points from all .par files contained in the parcels directory, as well as the attributes from the Access database.

You have now completed the exercise ‘Creating the Spatial ETL tool’.

In the next exercise, you will use Workbench to create polygons from the MGE LOT_LINES data, then add attributes to the polygons from LOT_POINTS.

---

Modifying the Spatial ETL tool

1. Edit Import MGE Parcels tool that you created in the previous exercise. Right-click the tool and click Edit. This will launch Workbench.

   Once Workbench is open, you can begin to modify the tool. First, you will add a transformer. Transformers are the geoprocessing building blocks of Workbench used to manipulate features.

2. To add the transformer, click the Gallery tab in the bottom-left pane; type “areabuilder” in the search box; and click Find.
3. When the results are displayed, double-click or drag the AreaBuilder transformer onto the main Workbench window (canvas).

4. Click the line connecting the GeometryFilter and the LOT_LINES destination feature type and press Delete. This will disconnect the LOT_LINES destination feature from the GeometryFilter. Connect the GeometryFilter to the AreaBuilder by clicking the yellow arrow beside the LINE attribute and dragging the arrow to the AreaBuilder INPUT. The AreaBuilder INPUT arrow turns green.

5. Select and delete the connector to the LOT_POINTS destination feature.

6. Use the Transformer Gallery to find and add a PointOnAreaOverlayer. This transformer will allow you to add attributes to the LOT_LINES areas.

7. Connect the GeometryFilter POINT Point output to the PointOnAreaOverlayer POINT input. Connect the AreaBuilder AREA output to the PointOnAreaOverlayer AREA input.

Right-click a connector line and click Insert Vertex on Link. This adds vertices so you can route arrows around your work flow.

The PointOnAreaOverlayer creates attributes for each polygon based on the point it contains. It also creates an Overlaps attribute that is useful for validating data.
Note: Overlap Count Attribute may be named something other than overlaps (such as _overlaps). You can edit the parameter by clicking on Edit Parameter on the PointOnAreaOverlayer transformer and change the name to overlaps.

If the Overlaps attribute for a polygon is greater than 1, there are multiple points inside that polygon. If the Overlaps value is 0, there are no points for that polygon. In this case, you want to test the Overlaps value, and if it’s not equal to 1, you will output these features as error_polygons.

8. To do this, search the Transformer Gallery for a Tester transformer, and add the Transformer to your workflow.

9. From the PointOnAreaOverlayer, connect the AREA output to the Tester input. To specify the test, click the properties button on the Tester transformer.

10. Type “overlaps” in the left Value field, and “1” in the right Value field on the Tester Properties dialog box.

Note: The properties button displays an exclamation point because one of the underlying fields is blank. You will have to edit the dialog box.
11. Click OK to close the dialog box. Notice that the Properties button has now changed to an ellipsis (…), indicating that you have edited the Properties.

12. Click the Properties button of the LOT_LINES destination feature. Type "Problem_polys" to change the Feature name and "geodb_polygon" to change the geometry. Now the geometry is correct and the output features can accept the new attributes.

13. Click the User Attributes tab, select all the attribute names (using Ctrl + left-click, or Shift + left-click), then click Delete. This will remove all the attributes from your destination feature. These are old line attributes, and they no longer apply to your new polygon features.

14. Click OK to close the dialog box.

15. Click the Properties button of the LOT_POINTS destination feature. Type "parcels" to change the Feature type name and "geodb_polygon" to change the geometry. Do not delete any user attributes for this destination feature. These attributes are from the original points that you want to save with your parcels.

16. Click OK to close the dialog box.

17. Connect the PASSED output from the TESTER to the parcels destination feature and the FAILED output to the Problem_polys destination feature.

18. Expand the parcels destination feature (if it is not already expanded) by clicking on +.
19. Since the Interactive Graphic Design Software (IGDS) format attributes that were originally in the MGE file are now meaningless, you can delete them. Right-click igds_class on the parcels destination feature and click Delete Attribute.

20. Repeat this for all attributes starting with igds.

21. Click the Properties button on the Problem_polys destination feature and click the User Attributes tab.

22. Type “num_points” in the Attribute Name column. Change the data type to integer. This will add a new attribute to capture the number of points that overlapped the Problem_poly.

23. Click OK to close the dialog box.
At this point, you will notice that the arrow going into the num_points attribute is red. This means that Workbench could not find an attribute in the Tester that matched that name. To populate this attribute with the values from Overlaps, you must manually connect them.

24. Left-click on the Tester FAILED overlaps yellow output port, and drag the line across to the num_points red input port. Both ports will turn green.

25. From the Workbench Navigator window, on the Workspace tab, right-click the Destination Redirect: attribute under Tool Settings and click Edit Parameter.

26. Click Redirect to Visualizer from drop-down menu. This will give you an idea of what the data will look like when you run this tool.
27. Click the Workbench Run button to preview the data.

28. This view of the data allows you to assess the output before running the tool and creating a dataset on disk. This is just an in-memory view of the data. When you are done viewing the data, close the Visualizer.

29. Click File then click Save to save your work in Workbench, but leave the Workbench window open for the next part of this exercise.

You have created a Spatial ETL tool that will read MGE data, create polygons from the lines, and overlay the points on the area’s merging attributes. This tool can be run by itself, as in the first exercise, or used in a geoprocessing model. The output will be a file geodatabase.

Saving the Spatial ETL tool as a Custom Format

Sometimes it is useful to apply the geometry and schema transformations of a Spatial ETL tool to data without actually importing it into ArcGIS. In this way, you don’t make a copy of the data, but you view the original data directly after you have applied the transformations. To do this, you can save your Spatial ETL tool as a Custom Format.

1. Click File then Export as Custom Format.
2. Type “Custom_Parceds” as the new custom format name, “Custom Parcels” as the description, then click OK to close the dialog box.

3. You will now have two open Workbench windows: one window shows the Spatial ETL tool and the other window shows the Custom Format. Click File then click Exit to close both Workbench windows.

Now that you have successfully created your Custom Format, you can access it from the Interoperability Connections node.

Restart ArcCatalog so that it can refresh its file type mappings. When you browse in the catalog tree to files with a .par extension, they will be automatically read via your newly created custom format.

In the next exercise, you will be exporting bird information stored in the personal geodatabase to AutoCAD®. The nests in the resulting AutoCAD files will be represented as symbols (blocks), where the specific symbol type is set depending on the cover type that was observed for each nest. In addition, the block rotation must be set correctly to reflect the observed nest direction.
Exercise 2: Using Spatial ETL to transform data from a geodatabase

Creating the Spatial ETL tool


2. Right-click the Spatial ETL Tools toolbox and click New then click Spatial ETL to rename the new toolbox.

This displays a wizard from which you select layers to use as input to the tool. These layers will be used as a template for building the tool; when the tool is run later, any layer or layers can be used as input to the tool.

3. Click Browse to display the Formats Gallery, when prompted to select the format of your source data, and double-click ESRI Geodatabase (File-based). Click Next.

4. When prompted to Locate Sample Source Data, click Browse and navigate to \ArcGIS\ArcTutor\Data_Interoperability\Tutorial\birds_eggs, click nests.gdb and click Open.
5. Click Next.
6. Select AutoCAD DWG/DXF when prompted to select the destination format then click Next.

7. Click Next when prompted to specify destination settings.
8. Click Finish to create the workspace.
Workbench will open, showing a default mapping of the NESTS table to the NESTS layer in AutoCAD.
9. Expand the source and destination types.
Add a ValueMapper transformer to the Workbench canvas and connect it between the source and destination features. This will map the different nest cover types to different AutoCAD symbols.

10. Edit the ValueMapper properties.

11. Select the COVER Source attribute in the Edit ValueMapper Transformer dialog box. This is the attribute from the geodatabase features that will determine the mapping. You must also define how the values for this attribute map to the block types.

12. Define how the values for this attribute map to the block types. Fill in the dialog box fields as shown below. The default value is defined in case any values are not matched. Note that all entries are case-sensitive.

13. Click OK to close the dialog box. The block_name attribute will be added to the output of the ValueMapper; this attribute will contain the mapped value.
Next, you’re going to expose the autocad_block_name, autocad_entity, and autocad_rotation attributes on the destination feature type. These attributes are used to tell the writer how to write the blocks in the output file.

14. Edit the properties for the output feature type, and in the Format Attributes tab, check the boxes beside autocad_block_name, autocad_entity, and autocad_rotation attributes as shown.

15. Click OK to close the dialog box.

16. Double-click the red port beside autocad_entity. Type “autocad_insert” to replace New Constant.

17. Connect the block_name attribute to the autocad_block_name attribute and the ROTATION attribute to the autocad_rotation attribute.

Each nest feature will be represented by the proper symbol, rotated in the proper direction.
18. Click the Workspace tab in the navigation tree on the left and expand the DWG output parameters. Right-click the Template File parameter and click Publish Parameter. This will open the Edit Published Parameter dialog box.

19. Click the Parameter Default Value’s browse button. Browse to \birds_eggs\template.dwg (which contains all the blocks referenced earlier in the ValueMapper).

20. Click OK.

21. Save your work and exit Workbench.

22. You can now run the tool on its own from ArcToolbox or include it in a ModelBuilder model. To run the tool, double-click it in ArcToolbox and fill in the required parameters, and then use ArcCatalog to examine the resulting AutoCAD file.

Modifying the Spatial ETL tool

In this part of the exercise, you will modify the Spatial ETL tool you created in the previous exercise to also write out a GML file containing the nest data.

1. Right-click on the Spatial ETL tool you created and click Edit. Workbench starts up.

2. Click Destination Data then click Add Dataset. Select GML Version 3.1.1, Simple feature profile compliant, as the Format and type “output.gml” as the dataset.
3. Click OK.

4. Click No when asked if you want to add a new feature type to the dataset. Instead of making your own feature type from scratch, you will make a copy of the one used in the AutoCAD output.

5. Right-click the AutoCAD output feature type NESTS and click Duplicate. Connect the new output feature type to the ValueMapper output.

6. Edit the properties for the new feature type. Under the General tab, change the Dataset value to GML_2, and set the Allowed geometries to gml2_point, as shown. Each GML2 feature type can only hold a single geometry, so you must specify it here.

If you were to run the tool right now, you would get a single output .gml file with a single feature type (NESTS_2) containing all the nest features.

It would be more useful if the GML file contained a separate feature type for each nest cover type. You could add new output feature types for each possible cover type (giving you feature types such as WILLOW, BARE, and ROCK), but that would not scale well when the possible cover types change.
Instead, you can use the Feature Type Fanout to instruct Workbench to dynamically make new output feature types based on the value of an attribute.

7. Check the Fanout feature type check box, and choose the COVER attribute to fan out, as shown.

8. Click OK to close the dialog box.

9. You’ll want to make sure the user is prompted for the output GML file whenever the tool is run. In the tree view on the left, locate the GML output dataset, right-click the Destination GML Dataset, and click Publish Parameter.

10. Save your work and exit Workbench.

11. Double-click the tool in ArcToolbox. You will be prompted for a GML file to write in addition to the AutoCAD file that was previously being written.
12. Click the folder icon in the NESTS Input Layers field.

13. Double-click nests.gdb\NESTS.

14. Type "\output\nestout.dwg" in the OUTPUT AutoCAD File field.

15. Click OK.

The Spatial ETL Tool appears, and displays processing information.

16. Click Close when processing is complete.

You have now completed the exercise ‘Modifying the Spatial ETL tool’.
Appendix A includes the many tools to help you get started with Workbench.
Workbench interface

The following graphic describes the Workbench interface. The list below describes the functions on the Workbench interface.

1. Run Button
2. Visualizer Button
3. Source Dataset Node
4. Source Parameters Node
5. Coordinate System Node
6. Workspace Tab
7. Transformer Gallery
8. Source Feature Type
9. Source Properties
10. Attributes
11. Transformer
12. Properties
13. Destination Feature Type
14. Destination Properties
15. Connector
16. Output Ports
17. Input Ports
18. Navigator Pane
19. Canvas
20. Log Pane
Menu bar and toolbar

The pulldown menus on the top of the Workbench window contain commands that will affect the entire canvas; whereas individual command menus (displayed by right-clicking after selecting an object on the canvas) are applicable to separate components.

The toolbar gives you quick access to various commands. To separate individual tools from the main toolbar as shown below, grab the toolbar handle and drag it onto the canvas.

Tools for managing layout

Hover your cursor over a tool to view a short description of its function. Layout tools allow you to perform the tasks below.

- Automatically arrange the screen layout.
- Select more than one node and align the tops, bottoms, or right or left sides.
- Expand or collapse—show or hide—the attributes of all feature types.

Tools for enhancing the canvas

Hover your cursor over a tool to view a short description of its function. View, File, Edit, and Insert tools allow you to perform the tasks below.

- Pan, zoom, and zoom to extents.
- Save, print, save to a mapping file, and run Workbench.
- Cut and paste, undo, and redo changes.
- Add source and destination datasets.
- Add a new feature type.
- Add a standalone comment. Right-click to associate it with a feature type or transformer.
- Specify a constant value to be assigned in the output data—for example, you might always want a pen_color to be a specific number.
- Insert a Visualizer transformer within the workspace to start the Viewer.

Status bar

The area at the bottom, left side of the Workbench window displays progress information as well as short descriptions of selected menu items or tools.
Workbench elements

When Workbench runs, it reads the feature type attributes from the input data. It initially displays the same feature types and attributes for the output data. So you will often have something that looks like the following.

Color definitions

The Properties button is on the top, right side of the Transformer. It can appear in different colors, and it can display an exclamation point or an ellipsis.

In most cases, Transformers contain default values that you can use when you run Workbench. However, if the Properties button is red and displays an exclamation point, then one of the fields is blank. You will have to enter a value before you can run Workbench.

If the Properties button is yellow and displays an ellipsis, the transformer is using default values that will work, but you have not yet confirmed that the default values are appropriate. To do this, click the Properties button, examine the values, make any changes, then click OK in the Edit dialog box.

If the Properties button is the background color and displays an ellipsis, you have already saved the value. If you still want to edit the value, click the Properties button to open the Edit dialog box.

Input arrow is red: A red arrow is a notification that there is no input for this port. If this is a feature port, no features are coming in; if this is an attribute port, no values have been set. This is not considered an error, since there are instances in which you might not want any input to a particular port.

Input arrow is green: The connection is set.

Output arrow is yellow: You don’t have to connect the output, but its value will be lost when you run Workbench.

In general:

- Red arrows: Double-check to make sure any missing input is intentional.
- Green arrows: The connection is properly matched.
- Yellow arrows: The value being produced will be lost.
Quick changes

To rename an attribute without opening the Properties dialog box, select the attribute name, then click Rename from the command menu. You can also press F2.

Create successive new attributes by selecting the entire destination type and clicking Add Attribute from the command menu. Enter new names in the dialog box that appears, and tab through the fields to accept the default values and complete the entries.

When you click OK, the attributes appear on the Workbench canvas.

You can go back later and edit the attribute properties by selecting the attributes and clicking Properties from the command menu.

Delete a connection by clicking directly on the link and pressing Delete or right-clicking and clicking Delete on the command menu.

To choose more than one link, do one of the following:

Hold down the left mouse button, drag the cursor in a rubberband around an area, release the mouse button, and press Delete.

Inserting transformer connections

This saves time if you already have many connections and want to insert a transformer between them.

Drag a new transformer onto the canvas.

Select the transformer; right-click; and from the command menu, click Insert Before.

A wizard guides you through the connection settings.

The new transformer appears on the canvas.

Inserting vertices on links

Select a connection; right-click; and from the command menu, click Insert Vertex on Link. This allows you to route your connections around other areas on the canvas.
Log

The log pane displays statistics and processing information, including the following:

- Reader being used
- Writer being used
- Logging information
- Warning messages
- Software version

Information messages are displayed until the Workbench task is complete. From the log, you can search for text, copy selected contents of the window directly to another application, or save the contents to a text file.

Note: The text in this area contains important information on the translation. If you ever get results you did not expect in your output data, check the contents of the log.

Viewing log files

Click Workbench Tools, click the Options menu, then click the Data Interoperability tab.

If the Write to Log Files box is checked, log files will be saved in a default location. Click the View Logs button to open a file browser that displays the list of log files. You can view the log files with any text editor.